
1 Vodič kroz Premiere Pro 2.0

Teme koje se obrađuju u ovoj lekciji:

•	 Video montaža: nekada i danas;
•	 Premiere Pro 2.0: aplikacija za nelinearnu video montažu;
•	 Upoznavanje sa uobičajenim procesom digitalne video montaže;
•	 Poboljšavanje radnog procesa pomoću vrhunskih alatki;
•	 Uklapanje kolekcije programa Adobe Creative Suite Production Studio 
Premium® u radni proces;
•	 Upoznavanje sa radnim okruženjem u programu Premiere Pro;
•	 Prilagođavanje radnog okruženja.

Početak rada
Od starih glomaznih magnetoskopa i skupocene opreme za video pro-
dukciju, do profesionalnog načina montaže na personalnom računaru, 
prešli smo prilično dugačak put. U ovoj lekciji želimo da vas upoznamo 
sa istorijatom video montaže. Uvid u to kako su se ove stvari obavljale 
nekada omogućiće nam da bolje sagledamo jednostavnost onoga što se 
sada nalazi pred nama. Poštujući ovakvu logiku izlaganja, pokazaćemo 
osnovni radni proces koji sledi većina video montažera i objasniti kako 
se u sve to uklapa Premiere Pro, jedna od osam programskih alatki iz 
kolekcije Adobe Creative Suite Production Studio Premium. Konačno, 
upoznaćemo vas sa jedinstvenim i potpuno izmenjenim radnim okruže-
njem u programu Premiere Pro. Pravi proces video montaže započećemo 
tek u lekciji 2.

Video montaža: nekada i danas
Video montažeri su pre trideset godina po struci bili inženjeri. Zapravo su 
to i morali da budu, budući da su jedino oni znali kako se rukuje masiv-
nim, svojeglavim i složenim magnetoskopima. Morali su da nadgledaju 
stvari kao što su: bojenje kadrova (engl. color framing), vremensko sin-
hronizovanje i blanking. Video montaža je tada smatrana tehničkim 
zaduženjem, a nipošto umetničkim poduhvatom.
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Nakon što su mašine za montažu postale manje i jednostavnije za korišćenje, inže-
njeri su polako počeli da ustupaju svoje mesto umetnicima, međutim, montiranje 
na analognim (nedigitalnim) video trakama i dalje je bilo puno ograničenja. Svaka 
izmena nužno je dovodila do „gubitka generacije” (pojavljivanja zrna), narušavanja 
vizualnog kvaliteta do kojeg je dolazilo usled nimalo savršenog načina kopiranja ana-
lognog signala sa polazne video trake.

Da bi se napravili prelazi, kao što je recimo Cross Dissolve, bilo je potrebno koristiti 
tri video rikordera i veoma skupe elektronske skretnice (engl. switchers). Često se 
događalo da video rikorderi nisu pravilno sinhronizovani, što je dovodilo do podrh-
tavanja ili naglih rezova na montažnim tačkama.

Pojavljivanjem digitalnih video traka i programa za video montažu, gubitak genera-
cije, skakutavi prelazi – kao i skupoceni magnetoskopi i oprema za montažu – postali 
su deo prošlosti. Danas bilo ko, na personalnom računaru, pa čak i na laptopu, može 
da montira video zapis koji je trenutno spreman za emitovanje u medijima.

Premiere Pro 2.0 – aplikacija za nelinearnu video montažu
Premiere Pro je aplikacija za nelinearnu video montažu (nonlinear editor, NLE). Za 
razliku od starog načina video montaže zasnovanog na video trakama u kojima se 
montiranje načelno moralo izvoditi hronološki i u nizu, Premiere Pro vam omogu-
ćava da klipove pozicionirate, naknadno im menjate položaj, ili ih pomerate na bilo 
koje drugo mesto i u već dovršenom video zapisu.

Ako biste u sistemu zasnovanom na video trakama poželeli da zvučni zapis naknadno 
umetnete u sredinu zapisa već izmontiranog na video traci, taj zvuk biste morali da 
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ubacite preko postojećih izmena, a da zatim ponovo montirate sve ono što dolazi 
nakon tog mesta. Drugo rešenje je da napravite video kopiju segmenta priče koji 
dolazi nakon novonastale montažne tačke, pa da taj video snimak nasnimite u 
nastavku izmene (što dovodi do gubitka kvaliteta ovog dela video snimka).

Korišćenjem programa Premiere Pro i drugih aplikacija za nelinearnu video mon-
tažu, izmene se obavljaju jednostavnim biranjem klipova i video segmenata i njiho-
vim povlačenjem u već dovršenom video zapisu. Video segmenti se mogu uređivati 
zasebno, pa se naknadno mogu spojiti. Šta više, završna sekvenca može biti ta koja se 
montira prva.

Premiere Pro vam dopušta da radite onim redosledom koji se vama čini najzgodnijim.

Glavna prednost aplikacija za nelinearnu video montažu u odnosu na sistem zasno-
van na video trakama sastoji se u mogućnosti trenutnog pristupanja video klipovima. 
Nema potrebe za beskrajnim premotavanjem kilometarskih video traka unapred ili 
unazad da biste s mukom pronašli neki vrlo važan kadar. U programu Premiere Pro, 
od ovog kadra vas deli samo jedan pritisak tastera miša.

Upoznavanje sa uobičajenim procesom digitalne video montaže
Za izradu video zapisa u programima za nelinearnu video montažu, kakav je Premiere 
Pro, poštuje se osnovni radni proces. Posle nekog vremena, on će vam postati sasvim 
blizak. Načelno govoreći ovaj proces podrazumeva da treba da uradite sledeće:

1	 Snimite video zapis. 
2	 Prebacite (digitalizujte) video zapis na disk personalnog računara.
3	 Napravite grubu konturu montiranog zapisa, tako što ćete odabrati klipove, prema 
potrebi ih skratiti i smestiti na vremensku liniju.
4	 Postavite prelaze između klipova, dodate video efekte, i komponujete (uslojite) klipove.
5	 Napravite tekstualne objekte, špice ili druge grafičke objekte i ubacite ih u svoj proje-
kat.
6	 Dodate zvučni zapis  – u obliku naracije, muzičke podloge ili zvučnih efekata.

Napomena: Prilikom montaže video zapisa, ako vam tako najviše odgovara, prvo 
možete da se pozabavite zvukom.

7	 Umiksujte više audio šina ili upotrebite prelaze i specijalne efekte nad audio klipovima.
8	 Dovršeni projekat prebacite na video kasetu, sačuvate je u obliku datoteke, video zapisa 
za reprodukciju u realnom vremenu na Internetu, ili je narežite na DVD disk.
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Da biste preduzeli bilo koji od ovih koraka Premiere Pro vam nudi alatke koje imaju 
vodeće mesto na tržištu sličnih programskih rešenja. Kako je nivo materije koji se 
izlaže u ovoj knjizi predviđen za korisnike početnog i srednjeg nivoa znanja, glavni 
cilj lekcija koje slede je da vam olakšaju korišćenje alatki koje su zastupljene u uobi-
čajenom procesu montaže.

Poboljšavanje radnog procesa pomoću vrhunskih alatki
Premiere Pro nije samo raskošan skup alata neophodnih za uobičajenu digitalnu 
video montažu. On sadrži i dodatne mogućnosti koje mogu da unaprede proces 
video produkcije i poboljšaju kvalitet dovršenih projekata.

Jasno je da mnoge od ovih alatki nećete koristiti u svojim početnim video projektima. 
Međutim, kako budete unapređivali svoje veštine i budu rasli vaši apetiti za kvalite-
tom, sve češće ćete se oslanjati upravo na ove alatke koje pospešuju produktivnost. U 
knjizi koja je pred nama obradićemo sledeće teme:

•	 Napredna montaža zvuka – Premiere Pro nudi mnogo bolje audio efekte i alatke za 
montažu zvuka od svih drugih programa za nelinearnu video montažu, a sasvim sigurno 
i od većine programa za obradu zvuka. Napravite audio kanale sa ambijentalnim zvučnim 
sistemom 5.1, napravite korekcije na nivou odmerka (odbirka), primenite više audio efekata 
na bilo koji audio klip ili šinu, koristite ponuđene najsavremenije dodatne module i druge 
VST (Virtual Studio Technology) module.
•	 Napredna korekcija boja – Korigujte i poboljšajte izgled video zapisa pomoću dve nove 
alatke za korekciju boje.
•	 Napredne kontrole za ključne slike – Premiere Pro 2.0 vam nudi sasvim precizne kon-
trole koje su potrebne za fino podešavanje vizualnih efekata i efekata kretanja bez potrebe za 
izvoženjem u aplikaciju za rad sa kompozitima.
•	 Širok raspon hardverske podrške – Odaberite bilo koju karticu za digitalizaciju ili neku 
drugu hardversku opremu u skladu sa vašim potrebama i finansijskim mogućnostima. Pre-
miere Pro 2.0 podržava rad u formatima DV (digital video) i HDV (a compressed high 
definition video format) na računarima koji nisu preterano skupi, ali i na radnim stanicama 
visokih performansi koje obavljaju digitalizaciju video zapisa visoke rezolucije (HD). Šta više, 
ako poželite da svoju hardversku opremu dodatno unapredite i tako radite na formatu HD 
ili na filmu, neće biti potrebe da se odreknete poznatog okruženja programa Premiere Pro 
– što nije slučaj sa nekim drugim programskim rešenjima kod kojih se za različite formate 
koriste različiti interfejsi.
•	 E-pregledanje – Ubrzajte proces u kome vaši klijenti pregledaju i odobravaju rezultate 
vašeg rada tako što ćete projekte napravljene u programu Premiere Pro ubaciti u PDF doku-
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menta. Klijenti će moći da pogledaju video zapise korišćenjem aplikacije Adobe Reader, 
moći će da unesu svoje komentare u poseban obrazac, a zatim vam ih dostave elektronskom 
poštom. 
•	 Grafički procesori za ubrzavanje video efekata – Na modernim grafičkim karticama 
možete koristiti grafičke procesore (graphics processing units, GPU), kako biste u realnom 
vremenu izradili efekte listanja strane (engl. page curls), okretanja strane (engl. page rolls), 
preslikavanja klipa na lopte (engl. spheres with video mapped on them) i druge efekte za 
izobličavanja slike koji obično zahtevaju skupocenu hardversku opremu i dugotrajno gene-
risanje slike.
•	 Podrška za video format visoke definicije – Radite na bilo kom formatu visoke defini-
cije uzimajući u obzir HDV, HDCAM, DVCPRO HD, D5-HD i 4K filmske skenove (engl. 
film scans). Premiere Pro 2.0 podržava ove formate u bilo kojoj rezoluciji (720p, 1080i, 1080p) 
i pri bilo kojoj brzini slika (24, 23.98, 30, 60fps, itd.).
•	 Montaža materijala sa više video kamera – Sasvim lako i brzo možete da montirate 
bilo koji zapis korišćenjem više video kamera. Premiere Pro prikazuje šine za sve kamere 
na podeljenom ekranu, a montažne tačke se izrađuju biranjem odgovarajućeg ekrana ili 
pomoću tasterske prečice.
•	 Upravljanje projektom – Upravljajte svojim medijskim datotekama u samo jednom 
okviru za dijalog. U njemu možete pregledati, brisati, premeštati, pretraživati ili reorgani-
zovati klipove i omotnice za klipove. Objedinite svoje projekte premeštanjem samo onih 
medijskih datoteka koje zaista koristite u nekom projektu i kopirajte ih na jedno mesto. 
Zatim oslobodite prostor na računaru tako što ćete obrisati one datoteke koje ne koristite.

Uklapanje kolekcije programa Adobe Creative Suite 
Production Studio Premium® u radni proces
I uz sve postojeće alatke koje sadrži Premiere Pro ipak nije u stanju da obavi odre-
đene zadatke u produkciji video zapisa. Na primer:

•	 Vrhunski efekti kretanja u tri dimenzije
•	 Detaljna animacija teksta
•	 Izrada profesionalnog DVD diska
•	 Grafički objekti postavljeni u obliku slojeva
•	 Vektorski crteži
•	 Izrada muzičkih zapisa
•	 Napredno miskovanje zvuka, montiranje i obrada efekata
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Da biste mogli da koristite i neke od ovih mogućnosti, predlažemo vam da koristite 
kolekciju Adobe Creative Suite Production Studio Premium. Ona sadrži sve potrebne 
alatke za izradu neverovatnih video zapisa, a obuhvata sledeće programe:

•	 Adobe Premiere Pro 2.0
•	 After Effects 7.0 Professional
•	 Adobe Photoshop CS2
•	 Adobe Audition 2.0
•	 Adobe Encore DVD 2.0
•	 Adobe Illustrator CS2
•	 Adobe Dynamic Link
•	 Adobe Bridge

Centralni deo kolekcije Adobe Creative Suite Production Studio Premium
Premiere Pro 2.0 predstavlja centralni deo programske kolekcije Adobe Creative 
Suite Production Studio Premium sastavljene od osam zasebnih programa (verzija 
kolekcije sastavljena od tri programa, tzv. standardna verzija sadrži Premiere Pro 2.0,  
After Effects Professional 7.0 i Photoshop CS2). Svih osam programa uklopljeni su 
tako da se međusobno dopunjuju i unapređuju rad  korisnika.

Sledi kraći opis preostalih sedam programa u kolekciji Production Studio Premium:

•	 Adobe After Effects Professional 7.0 – Izborna alatka za grafičke objekte u pokretu i 
umetnike koji se bave specijalnim efektima.
•	 Adobe Photoshop CS2 – Standardni program za uređivanje slika i izradu grafičkih 
objekata.
•	 Adobe Audition 2.0 – Program za snimanje zvuka profesionalnog kvaliteta, za montažu 
zvuka i unapređenje zvučnih zapisa koji se isporučuje sa preko 5000 kratkih repetitivnih 
odlomaka – muzičkih odlomaka koje montažeri mogu da koriste kako bi napravili dovršene 
muzičke celine.
•	 Adobe Encore DVD 2.0 – Program za izradu DVD diskova vrhunskog kvaliteta 
osmišljen za integrisan rad sa programima Premiere Pro, After Effects i Photoshop CS.
•	 Adobe Illustrator CS2 – Profesionalni program za izradu vektorskih grafičkih objekata 
predviđenih za štampu, video produkciju i veb.
•	 Adobe Dynamic Link – Ova međuprogramska veza omogućava vam da u programima 
Premiere Pro i Encore DVD radite u realnom vremenu koristeći izvorne datoteke programa 
After Effects, bez potrebe za prethodnim generisanjem.
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•	 Adobe Bridge – Vizualni pretraživač datoteka koji nudi centralizovan pristup projek-
tnim datotekama, aplikacijama i parametrima u vašoj programskoj kolekciji.

Radni proces u kolekciji Adobe Creative Suite Production Studio Premium
Radni proces u programskoj kolekciji Adobe Creative Suite Production Studio 
Premium dobrim delom zavisi od vaših realnih potreba. Pa ipak, navodimo skice 
nekoliko mogućih modela radnog procesa:

•	 Upotrebite Photoshop CS da biste doterali slike izrađene pomoću digitalnih fotoaparata, 
skenera ili na osnovu video klipa iz programa Premiere Pro. Zatim ih izvezite u Premiere 
Pro.
•	 Izradite slojeviti grafički objekat u programu Photoshop CS, a zatim ga otvorite u pro-
gramu Premiere Pro. Postoji mogućnost da svaki sloj smestite na zasebnu šinu na vremen-
skoj liniji, što će vam omogućiti da efekte i pokrete primenite samo na odabrane slojeve.
•	 Na osnovu ponuđenih muzičkih petlji programa Audition izradite muzičke datoteke 
koje ćete zatim izvesti u program Premiere Pro.
•	 Za montažu zvuka profesionalnog kvaliteta i njegovo poboljšavanje u postojećoj video 
datoteci programa Premiere Pro, ili u zasebnoj zvučnoj datoteci, upotrebite program Audi-
tion.
•	 Korišćenjem alatke Dynamic Link, video sekvence programa  Premiere Pro otvorite 
u programu After Effects 7. Primenite efekte za složene pokrete i animaciju, a zatim ovako 
izmenjene sekvence vratite u Premiere Pro. Kompozitne datoteke izrađene u programu After 
Effects možete reprodukovati u programu Premiere Pro 2.0 bez prethodnog generisanja.
•	 Program After Effects 7 možete da upotrebite da biste izradili i animirali tekstualne 
objekte na način koji prevazilazi mogućnosti programa Premiere Pro. Ovako napravljene 
datoteke izvezite u Premiere Pro.
•	 Video projekte izrađene u programu Premiere Pro uvezite u program Encore DVD 
da biste ih koristili za svoje DVD projekte. Ove video zapise možete da koristite kao temelj 
projektnog zadatka ili kao pokretne menije.
U najvećem delu ove knjige pozabavićemo se uobičajenim radnim procesom koji se 
odnosi na program Premiere Pro. Pa ipak, u nekim lekcijama predočićemo vam kako 
se korišćenjem kolekcije Adobe Creative Suite Production Studio Premium mogu 
postići zaista veličanstveni rezultati.
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Upoznavanje sa radnim okruženjem u programu Premiere Pro: 
Lekcija 1-1
U narednoj lekciji upoznaćemo proces nelinearne montaže. Za sada ćemo se samo 
nakratko osvrnuti na radno okruženje u procesu montaže. U ovoj lekciji ćemo kori-
stiti projekat koji se nalazi na pratećem DVD disku.

1	 Pretpostavka je da ste na disk računara prethodno kopirali sve omotnice sa lekcijama i 
kompletan sadržaj DVD diska. Podrazumevana omotnica je: My Documents\Adobe\Pre-
miere Pro\2.0\P Pro 2.0 CIB Assets\.

Napomena: Najbolje je da na disk računara kopirate sve lekcije sa pratećeg DVD diska 
i ne brišete ih sa diska sve dok ne dovršite rad u svim lekcijama u knjizi. Ovo je važno 
imati na umu budući da se u nekim lekcijama koristi materijal iz lekcija koje su pret-
hodno savladane.

2	 Osim toga, potrebno je da iz omotnice P Pro 2.0 CIB Assets sa pratećeg DVD diska 
kopirate datoteku P Pro 2.0 CIB Workspace.layout. Nju treba smestiti u omotnicu Pro 2.0 
Layouts korišćenjem sledeće putanje My Documents\Adobe\Premiere Pro\2.0\Layouts.
3	 Omotnicu Lesson Intro Videos i 18 video datoteka koje su zastupljene u njoj treba 
kopirati na isto mesto na koje su kopirane omotnice za rad sa lekcijama. Da biste repro-
dukovali ove uvodne video datoteke, potrebno je da pokrenete Windows Media Player, a 
zatim izaberite File > Open, otvorite omotnicu P Pro 2.0 CIB Assets\Lesson Intro Videos 
i sa dva uzastopna pritiska na taster miša izaberite datoteku Lesson 1 Intro.wmv.

Dodatne informacije o uvodnim video zapisima
Na pratećem DVD disku zastupljeni su kraći uvodni video zapisi za svaku od lekcija koje se 
obrađuju u knjizi. Ove datoteke imaju za cilj da vam vizualno predstave postupak kojim se 
postiže konačan rezultat rada u nekoj od lekcija. To bi trebalo da vam omogući što lakše usva-
janje sasvim novog koncepta rada.

U pitanju su datoteke u formatu WMV (Windows Media Video) koje se mogu reprodukovati 
u programu Premiere Pro ili u aplikaciji Windows Media Player. Površina za pregledanje u 
Media Playeru je mnogo veća nego u prozoru Program u programu Premiere Pro, tako da se 
preporučuje njihovo pregledanje u Media Playeru.

Video zapisi su izrađeni u rezoluciji 1024x768 što obezbeđuje potrebnu oštrinu slike prilikom 
reprodukcije u režimu punog ekrana u Media Playeru. Zapisi su snimljeni korišćenjem brzine 
od 10 slika u sekundi (što predstavlja otprilike trećinu uobičajene brzine slika digitalnog video 
zapisa, usled čega povremeno može doći do neznatnog mućenja slike u toku sekvenci koje se 
odvijaju u pokretu.

Nakon što dovršite pregledanje uvodnih video zapisa, zatvorite Media Player i pređite na naredni 
korak u datoj lekciji. Prema potrebi, možete ponovo da pogledate ove pomoćne video datoteke.
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4	 Pokrenite Premiere Pro.
5	 Izaberite Open Project.

6	 U prozoru Open Project, pronađite omotnicu P Pro CIB Assets > Lesson 1, a zatim sa 
dva uzastopna pritiska na taster miša izaberite datoteku Lesson 1.prproj. Otvoriće se kori-
snički interfejs.
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Izgled radnog okruženja
Ako do sada niste imali priliku da vidite program za nelinearnu montažu, možda će 
vam se njegovo radno okruženje učiniti zastrašujuće. Nema razloga za brigu. Mnogo 
promišljenog rada je uloženo u izradu ovakvog okruženja. Na sledećoj slici su ista-
knuti njegovi osnovni elementi.

panel Projectpanel Tools monitori

panel E�ect Controls prozor Timeline

Korisnicima koji se po prvi put susreću sa radnim okruženjem nekog programa za nelinearnu montažu 
ono se može učiniti zastrašujućim, međutim uskoro će i sami uvideti logiku koja se krije u njegovoj 
pozadini.

Premiere Pro 2.0 nudi potpuno unapređeno radno okruženje sa mnoštvom novih 
odlika koje ćemo obraditi u ovoj lekciji. Uz ova nova rešenja dolazi i sasvim nova 
nomenklatura. Potpuno su iščezle palete i većina prozora. Dodati su paneli, okna i 
plutajući paneli.

Svaki element radnog okruženja nalazi se u sopstvenom panelu. A više panela može 
se pričvrstiti za jedno okno. Pojedini već prihvaćeni elementi potpuno su samostalni, 
kao recimo Timeline, Audio Mixer i Program Monitor. U opisima elemenata radnog 
okruženja navodimo sve nove nazive (kao i neke stare).



ADOBE PREMIERE PRO 2.0
Učionica u knjizi

17

•	 Timeline – U ovom prozoru se odvija najveći deo montaže. U njemu se izrađuju 
sekvence (izraz koji firma Adobe koristi za montirane video segmente ili projekte u celini). 
Glavna pogodnost sekvenci sastoji se u tome što mogu da se ugnežđuju – dakle, jedna 
sekvenca se može postaviti u neku drugu sekvencu. Na taj način se izrada projekta može 
razbiti na nekoliko elemenata kojima se lakše rukuje.

   Više šina nego što realno možete da koristite

Video klipove, slike, grafičke objekte i titlove možete u obliku slojeva (kompozit) da 
smestite na neograničen broj šina. Video klipovi koji se nalaze na šinama označenim 
većim brojevima dolaze preko sadržaja koji se nalazi ispod njih na vremenskoj liniji. 
Otud je klipovima na ovim šinama potrebno obezbediti veću providnost ili na neki 
način smanjiti njihovu veličinu, ako želite da klipovi na šinama sa nižim brojevima 
budu vidljivi. O kompozitima (slojevima) biće više reči u narednim lekcijama.

•	 Monitori – Monitor Source (levo) može se koristiti za pregledanje i grubo skraćivanje 
klipova (polaznog video zapisa). Da biste neki klip smestili u monitor Source, sa dva uzasto-
pna pritiska na taster miša izaberite Video 1a na panelu Project. Monitor Program (desno) 
namenjen je pregledanju razvoja projekta na kome radite.

   Prikaz jednog ili dva monitora

Pojedini montažeri prednost daju radu sa jednim monitorom. Autor knjige više voli 
da koristi oba monitora, tako da je ovaj način rada zastupljen u knjizi. Prema želji 
možete da odaberete prikaz samo jednog monitora. Pritisnite dugme  ‘x’ na kartici 
Source da biste zatvorili taj monitor. Iz menija Main, izaberite Window > Source 
Monitor, ako poželite da ga ponovo otvorite.

•	 Panel Project – Predstavlja mesto na koje se postavljaju veze do projektnih celina: video 
klipova, audio datoteka, grafičkih objekata, slika i sekvenci. Za organizaciju ovih elemenata 
koriste se omotnice.
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•	 Panel Effects – Ako poželite da otvorite panel Effects (levo, dole) pritisnite jezičak na 
vrhu panela Project. Efekti su organizovani u grupe Presets, Audio Effects, Audio Transiti-
ons, Video Effects i Video Transitions. Ako otvorite neku od ovih omotnica primetićete da 
su u njima zastupljeni brojni audio efekti predviđeni za unapređenje zvuka; dva prelaza za 
ukrštanje zvučnih zapisa; prelazi video scena, kao što su Dissolves i Wipes; i mnogobrojni 
video efekti predviđeni za izmenu izgleda vaših video klipova.

Panel Effects (levo) i Audio Mixer (desno)

•	 Audio Mixer – Da biste ga otvorili, pritisnite jezičak Audio Mixer desno od jezička 
Effects (desno, gore). Sa klizačima za jačinu zvuka i kontrolama za premeštanje i ujednača-
vanje ovaj interfejs umnogome podseća na studijsku opremu za snimanje zvuka – po jedan 
skup kontrola za svaku audio šinu u prozoru Timeline i još jedna šina Master.



ADOBE PREMIERE PRO 2.0
Učionica u knjizi

19

•	 Panel Tools – Svaka ikona u ovom panelu (desno, dole) označava alatku koja obavlja 
određenu funkciju, a u vezi je sa montažom. U starijim verzijama programa Premiere bilo je 
zastupljeno mnogo više alatki, međutim, sada se alatka Selection () ponaša shodno situaciji 
u radu. Ona se menja poprimajući izgled koji odgovara funkciji koju je moguće preduzeti 
pod datim okolnostima.
•	 Panel Effect Controls – Pritisnite jezičak panela Effect Controls (levo, dole) da biste 
otvorili ovaj panel, a zatim izaberite bilo koji klip u prozoru Timeline. Na panelu Effect 
Controls pojaviće se parametri za efekte tog klipa. Ovo će vam obezbediti samo manji uvid 
u ono što predstoji u lekcijama koje slede. Za svaki video zapis uvek su zastupljena dva video 
efekta, bez obzira na to da li je reč o grafičkom objektu ili slici: Motion i Opacity. Parametri 
za svaki od efekata (u ovom slučaju za efekat Motion: Position, Scale Height and Width, 
Rotation and Anchor Point) mogu se podešavati u vremenu upotrebom ključnih slika. Panel 
Effect Controls je izuzetno moćna alatka koja vam pruža neslućene kreativne mogućnosti. 
O njemu se govori u mnogim lekcijama u knjizi.

Panel Effect Controls (levo) i panel Tools (desno)
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•	 Panel Info – Pritisnite jezičak Info (levo od jezička Effect Controls). U ovom panelu su 
predstavljene informacije o bilo kojoj celini koju ste izabrali u panelu Project, ili o bilo kom 
klipu ili prelazu koji ste odabrali u sekvenci.
•	 Panel History – Pritisnite jezičak History (levo od jezička Info). Panel History beleži sve 
korake koji se preduzimaju tokom izrade nekog video zapisa i omogućava vam da se vratite 
na neki od zabeleženih koraka u slučaju da vam se ne dopadne ishod neke preduzete ope-
racije. Nakon što se vratite na neki od prethodnih koraka, svi koraci koji su usledili za njim 
biće poništeni. Ne postoji mogućnost da izdvojite samo jedan pogrešan korak iz ponuđene 
hronološke liste.

Panel History (levo) i panel Info (desno)

Prilagođavanje radnog okruženja: Lekcija 1-2
Firma Adobe potpuno je unapredila korisnički interfejs programa Premiere Pro 2.0, 
kao i nekoliko drugih programa u kolekciji Adobe Creative Suite Production Studio 
Premium. U nastavku su izložene novine:

•	 Kada izmenite veličinu jednog okna, saglasno se menja i veličina ostalih okana
•	 Svim panelima unutar nekog okna može se pristupiti pomoću jezičaka
•	 Svi paneli se mogu pričvrstiti – panel iz jednog okna možete odvući u neko drugo okno 
i na taj način radno okruženje prilagoditi sopstvenim potrebama
•	 Panel se može postaviti u zaseban plutajući panel
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U ovoj lekciji ćete isprobati sve navedene funkcije i sačuvati tako nastalo radno okru-
ženje. Rad ćete nastaviti tamo gde ste zastali na kraju Lekcije 1-1. Pre nego što izme-
nite raspored elemenata u interfejsu podesićete njegovu osvetljenost.

1	 Izaberite Edit > Preferences > User Interface.

2	 Prema želji, povucite klizač Brightness ulevo ili udesno. Nakon toga, pritisnite dugme 
OK.

   Rad u zatamnjenim prostorijama

Kada izaberete najveću vrednost za tamno, tekst će postati beo na sivoj pozadini. Ova 
opcija je predviđena za one montažere koji rade u zatamnjenim prostorijama.
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 3	 Postavite kursor na vertikalni graničnik između panela Effect Controls i prozora 
Timeline. Pritisnite taster miša i povucite ulevo ili udesno da biste izmenili veličinu 
ovih okana.

Napomena: Kursor se na trenutak zaustavlja pošto se vertikalni graničnik između dva 
okna poveže – poravna – sa graničnikom nad sobom koji se nalazi između monitora 
Project i Source (kada držite pritisnut taster Shift i u isto vreme povlačite graničnik 
privremeno ćete isključiti funkciju Snap).

4	 Koristite funkciju Snap da biste okna podesili tako da se njihovi graničnici poravnaju. 
Četiri ugla na oknu treba da izgledaju kao na slici niže.

   Programska pomoć u datom kontekstu

Premiere Pro nudi trenutnu pomoć shodno situaciji u kojoj ste se našli, a to čini pomoću: 
oznaka i poruka koje prikazuje u donjem delu interfejsa. Na primer, kada pritisnete mišem 
na graničnik okna, na dnu se pojavljuje poruka koja vas upoznaje sa funkcijom Snap. Ako 
se kursor pomeri preko kontrola na monitoru Program, pojavljuju se njihove oznake.

5	 Postavite kursor na horizontalni graničnik između panela Effect Controls i panela Pro-
ject i pomerajte panele nagore ili nadole.
6	 Pritisnite levi ugao jezička panela History (marker za povlačenje) i povucite ga na vrh 
interfejsa, odmah pored jezička Project, kako biste ga pričvrstili za to okno.
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Napomena: Dok panel pomerate unaokolo, Premiere Pro prikazuje zonu u koju će on 
biti postavljen. Ako se pojavi pravougaonik, panel će biti smešten u odabrano okno. Ako 
se pojavi trapez, otići će u sopstveno okno.

   Rad u natrpanom oknu

Kada se panel History smesti u okno u kome se nalazi panel Project, svi zastupljeni 
jezičci više nisu vidljivi. U tom slučaju nad jezičcima se pojavljuje klizač. Pomerite ga 
ulevo odnosno udesno da biste prikazali sve jezičke. Ako želite da otvorite sakriveni 
(ili bilo koji drugi) panel, iz menija Main izaberite Window, a zatim naziv panela.

7	 Pritisnite i povucite marker panela Effect Controls u položaj u visini polovine panela 
Project da biste ovaj panel smestili u posebno okno.
Kao što je prikazano na slici levo, zona spuštanja je u obliku trapeza koji prekriva 
donji deo panela Project. Otpustite taster miša i radno okruženje će izgledati kao na 
slici desno.
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8	 Pritisnite marker monitora Program i zadržite pritisnut taster Ctrl dok ga izvlačite iz 
njegovog okna. Zona spuštanja je sasvim drugačija i označava da ćete ga spustiti na plutajući 
panel.

9	 Spustite monitor Program na bilo koje mesto i napravićete plutajući panel. Ako želite da 
ga proširite, povucite jedan od markera u uglovima panela.
Plutajući panel možete da koristite onda kada poželite da znatno povećate vidnu 
površinu panela u odnosu na onu koja je ponuđena u njegovom oknu. Ova opcija je 
posebno korisna onda kada treba da podesite veći broj parametara u panelu Audio 
Mixer, Effect Controls i monitoru Program.

10	 Kada se vremenom izveštite u ovom postupku, možda ćete poželeti da napravite i saču-
vate namensko radno okruženje. Da biste to učinili, izaberite Window > Workspace > Save 
Workspace. Upišite naziv radnog okruženja i pritisnite dugme Save.

11	 Da biste otvorili radno okruženje koje je izrađeno za ovu lekciju izaberite Window > 
Workspace > P Pro 2.0 CIB Workspace. Ovo je idealan način da se vratite na polazno radno 
okruženje ako se postupak podešavanja otme kontroli.



Kratak pregled
Kontrolna pitanja
1	 Zašto se Premiere Pro smatra programom za nelinearnu montažu?
2	 Opišite osnovni radni proces u video montaži.
3	 Koja je uloga panela Project?
4	 Kako ugnežđene sekvence mogu da pojednostave postupak montaže?
5	 Šta se događa u monitorima?
6	 Kako i zašto ćete napraviti plutajuće prozore?

Odgovori
1	 Premiere Pro vam omogućava da video zapise, audio zapise i grafičke objekte postavite 
bilo gde u nekoj sekvenci (vremenskoj liniji), da menjate redosled medijskih klipova unutar 
sekvence, dodajete prelaze, primenjujete efekte i obavljate bilo koje druge operacije u mon-
taži onim redosledom koji najviše odgovara vašim potrebama.
2	 Snimite video zapis; prebacite ga na personalni računar; na vremenskoj liniji izradite 
sekvencu koju sačinjavaju video klipovi, audio klipovi i fotografije; primenite efekte i pre-
laze; dodajte tekstualne i grafičke objekte; montirajte audio zapis; i na kraju izvezite dovršeni 
projekat.
3	 U panelu Project se čuvaju i organizuju veze do projektnih celina.
4	 Sekvenca može biti projekat u celini ili samo jedan njegov segment. Ponekad je lakše 
raditi na samo jednom segmentu nekog većeg projekta, a zatim se ta sekvenca može ugraditi 
u sekvencu dovršenog projekta. Razbijanje projekta na manje sastavne celine može znatno 
da olakša rad na projektu.
5	 Monitori se koriste za pregledanje projekta i polaznih klipova. Kada u radu istovremeno 
koristite oba monitora – Source i Program – sirovi materijal možete da pregledate i skraću-
jete u monitoru Source, a u monitoru Program da nadgledate vremensku liniju sekvence dok 
je izrađujete.
6	 Ponekad vam je za rad u panelu potrebno znatno više prostora od onog koji je ponuđen. 
Na panelu Effect Controls ima toliko parametara da mogu da ispune čitav ekran. Da biste 
povećali prikaz panela, zadržite pritisnut taster Ctrl dok povlačite jezičak panela i tako ćete 
izraditi plutajući prozor.
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